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2 Introduction 

Introducing MyDisc 
Congratulations for choosing MyDisc, Microtech Systems’ leading-edge software. By acquiring this product, 
you have become a member of an elite group of computer users, expanding your capabilities beyond what 
was possible just a short time ago. 

MyDisc is unique because it gives you the power to create your own CDs, with exactly the content you want 
and with your own printed information right on the disc. The content can be any files available to you on the 
local area network you’re connected to. The printed information can be any text you want, laid out and 
formatted as you like, and imprinted over pre-printed CDs if you desire. 

Versions of MyDisc This Manual Applies To 
This manual covers version 1.1 of MyDisc, up to the next major release (which should be 2.0). The version 
number can be found by selecting About MyDisc from the Help menu. 

Introducing This Manual 
This manual is your friend. It will guide you through the entire process of using MyDisc, starting with 
installing it. In addition to information for the user, it also contains instructions on setting up and maintaining 
the software for the system administrator whose job it is to keep users happy. (This information is found in 
the Appendix of this manual.) 

If you’re installing MyDisc yourself, then just follow through this manual in sequence. (You can skip the part 
mentioned above if you’re not a system administrator.) 

What Exactly is MyDisc, And What Does It Do? 
MyDisc is software—computer programs—which gives the users in an organization the capability of creating 
custom CDs right from their desktop, using a local area network. There are two pieces of software; one, a 
program to set up custom CDs which runs on each user’s workstation; the other runs a CD creation “server” 
which actually produces (writes and prints) the custom CDs. 

Users on the network in the organization can use the MyDisc software on their workstation to create custom 
CDs, selecting the files they want to go on the disc and setting up the printing which will appear on the top of 
the disc. When the disc is set up, the user tells the CD creation server to make the disc. After the disc is made, 
the user simply walks over to the CD creation machine and picks up their disc, ready to use. The MyDisc CD 
creation service is similar to the shared laser printers found in many workplaces. 

What Do I Need to Use MyDisc? 
MyDisc requires certain equipment (hardware) to create CDs: 

  A CD-R production system: 
At present, only the Microtech ImageMaker/ImageAutomator CD-R production system is supported as a 
hardware “platform”. This system functions as a CD-R server on a network (see below) and includes a 
computer system for the ImageMaker system software, the ImageAutomator robotic CD handler and one 
or more CD printers installed on the ImageAutomator. (It can optionally include the ImageAligner 
hardware and software for printing on pre-printed CDs.) 

  A local area network: 
Both the computer you run MyDisc on and the CD-R production system must be connected to some type 
of local area network (such as a Microsoft Windows, Novell or Unix network). The network includes one 
or more network server computers, the network interface controller card in each workstation, and any 
cabling and other hardware connecting servers to workstations. 
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Limitations of MyDisc 
Before you start using MyDisc, you need to understand what it can do and its limitations. This will help 
avoid asking it to do something it isn’t capable of doing. 

  MyDisc can only copy network files: 
When you make custom CDs at your workstation, you can 
only select files which reside somewhere on the network 
you’re attached to. (The files will be either on a file server, 
or on another workstation with a shared drive.) You cannot 
select files on any of your own (local) drives. 
This seems strange: why can’t I use files on my own 
computer? The reason is that the actual file transfer—
locating and copying the files to CD-R discs—takes place on the production system, which is a remote 
computer on the network, like yours. The production system can’t “see” your local drives (unless they’re 
made shared), so it can’t pull any files from them. 

  Tip: 
To put files on your local computer onto a CD, first copy these files to a network file server, then use 
MyDisc to select these files. When you’re finished making your discs, you can delete the files from the 
network. 
Another way to get files from a local hard disk onto CD is to make the local hard drive sharable (set up as 
a shared device) on a network. The hard disk will then be “visible” to the production system, and any 
files on that drive can be copied to CD. The disadvantage of this method, however, is that other users on 
the network will now have access to that hard drive as well, which may or may not be desirable. 

 

The one exception to this rule is when you 
run MyDisc on the disc production system 
itself. This is covered (in the chapter titled 
Premastering CDs with the 
ImageAutomator 150) in the 
ImageAutomator 150 CD-R Production 
System User’s Manual. 
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Before you take advantage of MyDisc on your computer, you need to install it and set it up. If you work in an 
organization where you have computer administrative services, this task may be taken care of for you, in 
which case you can proceed to the next chapter to learn how to use MyDisc. Otherwise, read this chapter. 

Setting up MyDisc consists of two parts: 

1 Installing the software on your computer 

2 Configuring MyDisc to operate correctly on 
your computer 

Installing MyDisc Locally or Remotely? 
You have the choice of installing MyDisc either locally—that is, actually installing the software on each user’s 
workstation (computer system)—or remotely, where only a shortcut to the software is installed on the user’s 
workstation and the software actually resides on a network server. 

The advantages of running MyDisc remotely are: 

  It’s easier to upgrade the software when new releases come out, since only a single copy of the software 
need be replaced. 

  The software can be configured with the same defaults for all users, so that all users start out with the 
same settings. (Users can still change their own configurations to suit themselves.) 

The decision on which way to install MyDisc will normally be made by a system or network administrator 
whose responsibility is maintaining the network as well as user’s systems. The instructions below cover local 
installation. For remote software installation, refer to Remote Installation of MyDisc on page 40. 

Installing the MyDisc Software 
The MyDisc software in this package is on a CD. To install this software on your computer, follow the steps 
below. 

1 Put the CD in your computer’s CD-ROM drive. After the disc is recognized, the installation utility should 
automatically start and its window should appear on the Windows desktop. When it does, skip to step 2 
below. If it doesn’t automatically start, you’ll need to start it yourself. You can either use the Windows 

 button or use Windows Explorer to find and run the program: 

  Using The Windows   Button: 
Click this button, then choose Run… from the menu which pops up. The Run dialog will open. Click 
the Browse button. In the Browse dialog, choose the CD-ROM drive with the installation disc in it. 
On this disc, locate the file called Install (or Install.exe). Click on this file to select it, then 
click Open. Back in the Run dialog, click OK to start the installer. 

  Using Windows Explorer: 
Open Windows Explorer. In the left-hand pane, select the CD-ROM drive with the installation disc in 
it. Click on the drive’s icon to display its contents in the right-hand pane. Locate the file called 
Install (or Install.exe)and double-click on this file to start the installer. 

2 After showing a colorful “splash screen”, the installation program will appear as shown below. 

Note to system administrators: A third part of 
setting up MyDisc in an organization is configuring 
the disc production system properly to handle job 
requests from user’s workstation. This configuration 
is covered in the Appendix to this manual. 
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The installer lets you choose where you want the MyDisc software installed on your computer. By default, 
the following folder will be used: 

C:\Program Files\MyDisc 

To install in this folder, just click the  button. If you want to install the software somewhere else, 
click the  button. This will open a browser which lets you pick the drive and folder. After 
selecting the new location, click  . 

The following window will appear when the installer has successfully copied the program files to the selected 
folder: 

Click  . Now is a good time to create a Windows desktop “shortcut” to the software (an icon on 
the desktop you can click on to start the program). There are several ways to do this, depending on where the 
shortcut will be placed. (A shortcut can go directly on the desktop, in a folder on the desktop, or in the 
Windows Start menu.) Probably the easiest way to create a shortcut is directly on the desktop: 

3 Right-click on any open space on the Windows desktop. (You’ll need to close or minimize application 
windows if you can’t see the desktop.) From the menu which pops up, select New  Shortcut. 

4 Follow the directions in the Create Shortcut dialog. Instead of typing a command line in the first part, 
click the  button to open a standard Windows file selector. Locate the MyDisc.exe 
application where it’s installed on the workstation’s hard drive (this will be the same folder you selected 
in step 2 above). In the next step, do just what the dialog title says: Select a Title for the Program (hint: 
you don’t have to name the shortcut “Shortcut to…”). 

You can now use MyDisc by double-clicking its icon, shown here. (There’s no need to restart your 
computer.) 
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Before you start using MyDisc to create discs, read this chapter to learn about its basic operation and some 
general concepts it will be helpful to understand. Don’t worry—most of these this is simple and even 
common-sense! There are a few “advanced” concepts for those of you who have special CD-making needs; 
for most users, though, the basics are all that is needed. 

Making discs with MyDisc consists of the following two tasks: 

1 Selecting the files you want to put on your disc. 

2 Creating the print layout with the text which will print on the disc. 

Each of these tasks has its own on-screen “tab” which contains the tools and fields you need to do the task. 
When you’re done selecting the files and created the print layout, you go to the third tab to select the number 
of disc copies. Then you click the  button to start the disc-making process. 

After that, all you need to do is to go to the MyDisc CD-R production station where the discs are being made 
and pick the discs up from the “output” stack when they’re done. 

Starting the MyDisc Desktop Application 
To start the MyDisc desktop application, double-click the icon on the Windows desktop (shown 
here at the right). When the program starts, you’ll first see a colorful “splash screen”. After this 
stays up for a few seconds, the first thing you’ll see will be a dialog which asks you what type of 
disc you want to make. 

Decision Time: What Type of Disc Do You Want To Make? 
After MyDisc starts, you’ll be asked what you want to do. The dialog which asks you what type of disc you 
want to make is shown below. 

You need to know what kind of disc you want to make before you start, because data discs are fundamentally 
different from audio discs. Data discs contain “computer”-type data: graphic images, databases, spreadsheets, 
documents, etc. Audio discs contain music or other recorded material. Click the button for the type of disc 
you want to make, then click . 
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After you make your selection, the file selection “tab” will be shown. The file selector used when making data 
discs is slightly different from the one used for audio discs. The file selection details for both types are 
covered below. We’ll start by telling you how to make a data disc. (For instructions on selecting tracks for an 
audio disc, skip ahead to page 14.) 

Three Steps to Making a Disc, Three Tabs 

No matter what type of disc you’re making, there are three steps to making a disc. Each of these steps has a 
separate “tab” in MyDisc. These tabs are selected by clicking on the tab along the top of the window, below 
the menu and toolbar. The tabs are: 

  1) Select Files: † choose the files and folders you want to put on your disc 

  2) Create Disc Label: select the text you want to print on your disc 

  3) Make Disc/Image: select the number of discs (and other options), then “make it so”. 

† When you’re making an audio disc, this tab will say “Select Tracks” instead. 
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Step 1(a): Selecting Files and Folders for a Data Disc 
After you select the type of disc you want to make (a data disc in this case), you’ll be looking at MyDisc’s file 
selection tab. This window is shown below here. 

Notice how the selector is divided into 4 “panes”. The 
upper two panes are the “source” ones, while the lower 
two are “destination” panes. You get the files you want 
to go on your disc by selecting them and dragging them 
from the upper panes to the lower-left pane. Select an 
item by clicking the left (or primary) mouse button on 
the item; drag the item by moving the mouse while keeping the mouse button held down. 

The panes are also divided to show folders (on the left side) and the contents of the currently-selected folder 
(the right side). You can drag items from either top pane to either bottom pane: 

  To place an entire folder on your disc, drag the folder from the upper-left hand pane. This will bring in 
the folder and its entire contents (including any folders inside that folder, and any folders inside those 
folders, and so on). 

  To place a particular file or folder from the currently-selected folder (or a selection of multiple files) on 
your disc, select and drag the files from the upper-right hand pane. 

Only files and folders which reside on a 
network file server can be selected. You 
cannot select any files or folders on your 
workstation’s local hard drive or other local 
data storage devices. 

Source pane—folder contents Source pane—folders

CD “gas gauge”

CD destination pane (folders)

CD destination pane (folder contents)
Disc space indicator 

Current source 
path
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You can drag items (folders and files) to any place in the lower panes. In the following section, the current 
item refers to whatever item is displayed in the lower right-hand pane. (This will always be the contents of a 
folder in the lower left-hand pane.) In the display shown below, the folder Misc  is the current item (its 
contents are shown on the right). 

Here’s how you choose where an item will go on your 
disc: 

  If you drop the dragged item directly over a folder 
in either lower pane, the dragged item will go into that folder. 

  If you drop the dragged item outside of any items in the lower left pane (that is, in the clear space in the 
pane), the dragged item will go into the root of the CD—that is, at the “top level” of the disc volume. 

  If you drop the dragged item outside of any items in the lower right pane (in the clear space in the pane), 
the dragged item will to into whatever folder is currently open in the lower left pane. 

So in the previously shown example, if you drag an item (folder or file) from anywhere on the top to the 
bottom left pane and don’t drop it directly over any item, the dropped item will go into the root of the disc 
(indicated by “My Disc (root)” in the lower left pane). 

As you build your CD, check the “gas gauge” and the disc space indicator to see how much space you have 
left on the disc. As you add items, the gauge extends to the right. The disc space indicator at the lower right 
shows the amount of disc space used in megabytes. (If you try to choose an item which is too big to fit the 
available space on the disc, you’ll get a warning message.) 

Now that you’re done selecting files for your data disc, skip ahead to Step 2: Creating a 
Label for Your Disc on page 16. 
 

For advanced file-selection techniques which 
allow you to quickly select multiple files and 
folders, turn to page 16. 

Current
item

Contents 
of current 
item 



14 Using MyDisc 

Step 1(b): Selecting Tracks for an Audio Disc 
After you select the type of disc you want to make (a data disc in this case), you’ll be looking at MyDisc’s file 
selection tab. This window is shown below here. 

Notice how the selector is divided into 3 “panes”. The 
upper two panes are “sources”, while the lower one is a 
“destination” pane. To make your disc, drag the tracks 
you want from the source (upper-right pane) to the 
destination (lower pane). Select a track by clicking the left 
(or primary) mouse button on the track; drag the track by 
moving the mouse while keeping the mouse button held down. 

The panes are also divided to show folders (on the left side) and the contents (tracks) of the currently-selected 
folder (the right side). Only files which are valid audio tracks will be shown in the current folder. As you add 
tracks, the CD “gas gauge” and disc time indicator are updated to show how much space you’ve used on the 
disc. (The time indicator shows the total play time in minutes:seconds.) 

Selecting audio tracks is simpler than selecting files for a 
data disc (explained starting on page 12). For an audio 
disc, there are no folders on the destination (the audio 
CD), so you simply select and drag individual tracks or 
groups of audio tracks from the source. 

Only audio tracks which reside on a network 
file server can be selected. You cannot 
select any tracks on your workstation’s local 
hard drive or other local data storage 
devices. 

For advanced file-selection techniques which 
allow you to quickly select multiple tracks, 
turn to page 16. 

Source pane—folder contents Source pane—folders

CD “gas gauge” CD destination pane (folder contents) Disc time indicator 
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Arranging Audio Tracks on Your Disc 
You can arrange the order of audio tracks on your audio disc as you select the tracks. The order shown in the 
bottom pane is the order in which the tracks will play, just as with any ordinary music CD. You can rearrange 
the tracks in the lower pane by simply picking up and moving tracks. 

To move a track, select it by clicking on it with the primary mouse button. Move the selected track by 
continuing to hold down the mouse button. Let go of the mouse button to drop the track where you want it to 
go. 

Changing the Pause Between Audio Tracks 
Tracks on an audio disc are separated by pauses, which are small amounts of silence. Normally, MyDisc 
places exactly 2 seconds of silence between tracks. You can change the amount of pause between the end of a 
track and the beginning, either by double-clicking the track in the lower pane, or by right-clicking (using the 
alternate mouse button) on the track. This will open the following dialog: 

Set the desired pause time either by typing the time in directly, or by using the “spinner” control (the little 
arrows) to change the time by hundredths of a second. Click  to change the pause time, or  
to leave the pause time unchanged. Remember that you are changing the pause time between this track and 
the next one. To eliminate the pause entirely, set the time to 0. 

Now that you’re done selecting tracks for your audio disc, skip ahead to Step 2: 
Creating a Label for Your Disc on page 18. 
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Advanced File Selection: Selecting Multiple Items 
The “tricks” described here allow you to easily select multiple files (data files or audio tracks) and file folders 
for either data or audio discs. These are all standard Windows file-selection techniques which work in most 
(not all) applications which use some kind of file browser, similar to Windows Explorer. 

Selecting Multiple Folders and Files 
There are two kind of multiple selections for files and folders: 

  Range selections, where a contiguous group of folders or files is selected by marking the start and end 
of the range 

  Random selections, where you add folders or files individually to the selection 

To make a range multiple selection: 

There are two ways to make a range selection. One is by using the
 

Shift  key and clicking, while the other 

is by using marquee selection with the mouse only. 

To make a range selection by using the keyboard and clicking: 

1 Select the first item in the range by clicking on it. 

2 Move to the last item in the range. (You may need to scroll down in the pane to get to it.) Hold down the 

Shift

 
key, then click on the last item to select the entire range. 

To make a range selection by using marquee 
selection: 

1 Start the marquee selection by clicking near the first 
item in the range you want to select. You must click in 
the empty space outside of the name of the file or folder you want to select. 

2 Drag the marquee selection by moving the mouse with the button held down. You’ll see the marquee 
box, which is a dotted-line box with its corner where you started the selection. Drag this selection to cover 
the range of files you want to select. 

3 Complete the marquee range selection by letting go of the mouse button after all the items you want have 
been selected. 

Marquee selections are also known as 
rubberband selections, because the box 
you drag out with the mouse wraps around 
the selection like a rubberband. 

Marquee selection box 

Starting point 
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When you click on the last item (using the Shift

 
key) or let go of the marquee selection, the entire range 

will be highlighted to show that it’s selected. 

To make a random multiple selection: 
1 Select the first item by clicking on it. 

2 Select each subsequent item by holding down the
 

Ctrl  key and then clicking on the item to add it to the 

selection. Be sure to keep this key held down until you’ve selected all items. 

Each selected item in the random selection will be highlighted. 

To drag a range or random selection: 
Once you’ve made either a range or random multiple selection, you must click within the selection in order 
to drag it. Click directly on any of the highlighted items, then hold down the mouse button to drag the 
selection. When you drag a multiple selection, you’ll see a “ghost” outline of the items being dragged: 

To cancel a range or random selection: 
If you make a multiple selection, but then decide you don’t want to use it after all, simply click on any item 
inside the pane where you made the selection to cancel the multiple selection (whatever you click on will be 
selected as an individual item instead). 
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Step 2: Creating a Label for Your Disc 
After you’ve selected the files for your disc, it’s time to move to the next tab to set up the label which will be 
printed on the disc. You can put both text and pictures on a disc. With the ImageAligner option installed on 
the disc production system, you can even imprint text on discs with pre-printed artwork. 

If you don’t want any printing on your disc for some reason, then you can skip this part of the process. Just 
make sure that the disc printing layout shown on this tab is completely blank. (If it’s not, you can clear any 
items there by selecting the New layout item from the File menu when this tab is open.) 

Click on the Create Disc Label tab, shown above, to open it. The tab display will appear as shown below. 

The display shows the disc’s “playing field”, the circular area where you can put text and pictures. (You can 
turn the disc boundary and gridline displays on or off; see page 28.) 

Toolbar 
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The Disc Label Toolbar 
The disc label toolbar, located just under the menu headings at the top of the window, make several useful 
functions available by just clicking a button. This toolbar and its buttons are shown here below. 

Creating a New Printing Layout 
To create a CD printing layout, you put text and pictures on the disc where you want them to print. There are 
two ways to insert these items:  

1 By using the toolbar buttons, you can insert text or pictures, then move them where you 
want them in the layout. The first button on shown here inserts text while the second 
inserts pictures. If you want to insert a barcode item, you’ll need to use the “right-click” method below. 

2 You can right-click (using the “alternate” mouse button) to get the small menu (shown 
to the right here) to “pop up”. Select the type of item you want to insert from the menu. 
(When you move the pointer, notice that your position on the CD grid is shown at the 
lower right corner. This is the position where the item will be inserted in the layout.) 

3 You can select Add text, Add picture or Add barcode from the Edit menu. 

With either selection method, the insertion dialog corresponding to the type of item you selected will appear. 
There are three types of items you can insert:. 

  Text items: 
There are two kinds of text items you can place in a layout: 

♦ Single-line text items are just that: one line of text, of any length. 

♦ Text boxes include multiple lines of text within a box. A text box is created any time you insert more 
than one line of text in the Text Properties dialog. You move to a new line by using the 
<Enter> key. The box around the text is conceptual only (it doesn’t print on discs). The text within 
the box can be aligned to the left, center or right of the box. 

  Pictures: 
Pictures are bitmap or vector-based digital images which can be placed anywhere on a layout. 

  Barcodes: 
Barcodes are special text items which encode text Barcodes require special barcode fonts 

which are available from Microtech. Contact 
your dealer or sales representative for 
information. 

Load printing layout

“What’s This?” help 
Paste (text or picture) 

Insert text 
Set grid spacing 

Toggle grid display
Toggle disc outline display

Zoom
Toggle pre-printed graphic display

Load pre-printed graphic

Insert picture 
Cut (text or picture) 
Copy (text or picture) 
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(letters and numbers) as standard machine-readable barcode characters. 
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Inserting Text Items in a Layout 

Click the insert text toolbar button ( ) or right-click where you want the text item placed, 
then choose Text from the pop-up menu. The following dialog will appear. Fill in all 
appropriate items, then click OK to insert the text. Click Cancel instead if you decide you 
don’t want to insert the text after all. 

  Text: 
Type the text you want to appear in the text item here. You can also paste text from other Windows NT 
applications to include non-keyboard symbols in the text. 

  Size: 
Specify the size of the text (in points) here. 

  Font: 
Specify the font you want to use for the text here. A list of all fonts available on the ImageMaker 
Windows NT system will appear here; click on the font you want to select it. 

  Color: 
Select the color you want the text to appear in from the list in the box. To select any custom color, click 
the  button; this opens a standard Windows color-selection dialog. 

  Style:  
Click any check items here to select the desired style to apply to the text. 

♦ Bold and Italics apply these characteristics to the text in the usual way. 

♦ Transparent background controls how text is 
printed over bitmap pictures (either a background 
image or a picture). When this attribute is chosen, 
whatever is in an underlying picture will show 
through the text printed over that picture. 

Tip: if any text prints over pictures on your 
layout, experiment with background 
transparency by doing some test prints to 
determine how the final result will actually 
look before starting production. 
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Otherwise, a white (or non-printed) area will be printed around the text over the picture. (See below 
for an explanation of text transparency.) 

  Justification: 
Select the alignment you want to apply to the text item here. This is the horizontal alignment in relation 
to the entire text selection (a box for non-circular text); Center will center all text within this box. 

  Anchor: 
This setting determines which part of the text item—left side, center or right side—will snap to the 
“playing field” grid lines when the Snap to minor grid option is enabled in the Options menu. 
(See page 26 for more details on using object snap.) 

  Angle: 
This item sets the angular position of the text item. There are four choices: 

♦ Normal: 
Text will be aligned horizontally. 

♦ Circular: 
Text will be arranged in a circular path around the CD. The text will always be concentric with the 
center of the disc. The beginning and end of the arc formed by the text depend on where you place 
the text on the layout. 

♦ 90 Degrees: 
The text will be aligned vertically, starting at the bottom reading upwards. 

♦ 270 Degrees: 
The text will be aligned vertically, starting at the top reading downwards. 

A Note on Text Transparency 
As explained above, the Transparent background item in the Style choices controls how text is printed over 
bitmap pictures. Specifically, this choice controls whether the bitmap picture will show around the text or not. 
Here’s what happens in both cases: 

  If the Transparent background item is selected, then the bitmap picture will show through all around behind 
any text which prints over that picture. 

  If the Transparent background item is not selected, then a “white” (meaning non-printing) box will surround 
any text which prints over a picture. 

The illustrations below show how this works:  

Text  with t ransparent  background Text  without  t ransparent  background
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Positioning Text Items in a Layout 
The two types of text items—single lines and text boxes—are each handled a little differently when it comes 
to how the text is positioned on the layout. Here’s how each type works: 

  Single-line text items: 
This is the simplest case. The text is positioned wherever you place it on the layout. The 
Justification setting has no effect on positioning for single-line text items. The Anchor setting 
controls how the text item will snap to the “playing field” grid if the Snap to minor grid option is 
enabled. (See page 22 for more information on Anchor.) The Angle setting controls the item’s angular 
position. 

  Text boxes: 
These are multiple-line text items. The position of the entire item is wherever you place it on the layout. 
However, the position of each line text within the text box is controlled by the setting of the 
Justification control (Left, Center or Right). For Left justification, all text is aligned to the 
left side of the text box; for Center, the center of the box, and so on. 
The Anchor setting controls. how the text item will snap to the “playing field” grid if the Snap to 
minor grid option is enabled. 

Inserting Pictures in a Layout 

Click the insert picture toolbar button ( ) or right-click where you want the picture placed, 
then choose Picture from the pop-up menu. The following dialog will appear. Select the file 
containing the picture you want to insert, then click OK to insert it. (Click Cancel instead if you 
decide you don’t want to insert the text after all.) 

The picture file must be in one of following types of picture formats: 

FILE EXTENSION FILE TYPE 
.BMP Windows/OS-2 bitmap pictures 
.JPG JPEG (Joint Photographic Experts Group) pictures 
.EMF “Enhanced” Windows metafile format (vector) 
.TIF Tagged-image file format (TIFF) † 

† Only uncompressed TIFF files can be used with MyDisc. 

Once you have inserted a picture into your printing layout, you 
have several editing functions available to modify how and 
where the picture will print. See the section Editing Items in a 
Layout starting on the next page. 

Important! 
If you are going to print on pre-printed discs, 
using the ImageAligner option, you cannot 
place any pictures in the disc layout. (Only 
text can be rotated by ImageAligner.) 
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Inserting Barcodes in a Layout 
When you choose Barcode from the pop-up insertion menu, the following dialog will 
appear. (This assumes that you have the required barcode fonts installed on your 
computer system.) Fill in all appropriate items, then click OK to insert the barcode. Click 
Cancel instead if you decide you don’t want to insert the barcode after all. 

♦ Text: 
Type the text you want to be interpreted as a barcode here. 

♦ Font: 
Select the barcode font to use. (The list is a 
complete list of all available barcode fonts, not 
those which are actually installed on the Windows 
NT system. Go to the Windows NT Control Panel 
to check which fonts are installed.) Only Code 39 
barcode fonts are supported. 

  Note: If you don’t see the Barcode item in the pop-up menu, that means that you don’t have the 
required barcode fonts installed on your computer system. Contact Microtech customer service if this is 
the case. 

Editing Items in a Layout 
As you insert items into the disc layout, you’ll see them in the layout window. Once an item is inserted, you 
can move it anywhere on the layout. Selecting it by clicking on it; selected items appear with resizing handles 
around them, as in the illustration below. Move the selected item by moving the pointer with the left 
(primary) mouse button held down. When you release the mouse button, the item will stay in the new 

location. 

Besides moving and resizing items in the layout, you can change their properties. Pictures can be placed on 
top of or behind other pictures; text can be edited and its properties modified. For either item, these functions 
are available through context-sensitive menus; these are small menus which pop up when you right click 

You need to buy barcode fonts to use 
barcodes with MyDisc. Ask your sales 
representative or Microtech customer service 
for more information. 

Text pop-up menu 

Picture pop-up menu
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(using the right mouse button) on the item you want to change. The menu shown at the left above is the text-
editing menu you get when you right-click on a text item. The one on the right is the picture-editing menu. 
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Moving Items in a Layout 
To move any item in a layout (text, picture or barcode), simply select the item by clicking on it in the layout, 
and drag it to the desired place while holding down the mouse selection button (left button for right-handed 
users). 

If the Snap to minor grid option (in the Options menu) is checked, then the 
item will snap into position to the nearest minor grid. (The minor grid is shown in a 
lighter color than the major grid.) The spacing of the minor grid can be changed by 
clicking on the grid-spacing toolbar button (  ). In the case of text items, the part of 
the item which will snap to the grid depends on the setting of the Anchor control in 
the Text Properties dialog for the item. (Pictures always snap to the upper and 
left edges.) 

Resizing Items in a Layout 
To resize any item, simply grab any of its resizing 
handles and move it with the mouse pointer to the 
desired place. 

The side handles (the squares in the center of each side) resize the item in 
one dimension only; the corner handles resize in both dimensions. Grab a 
side handle and you can make the item larger or smaller in the direction of 
that side only. (The cursor changes shape, into a double-ended arrow, 
when resizing.) Be careful: you can distort a picture if you’re not careful 
by resizing it non-proportionally (more in one dimension than in the 
other). 

Covering an Entire Disc with a Picture 
You can cover the entire surface of a disc with a picture by resizing the picture manually. 
However, MyDisc includes a function to do this for you easily. Select the picture you 
want to cover entire disc in the layout by right-clicking on it (use the right mouse button). 
From the menu which pops up, click on Fit to CD. The picture will be automatically 
sized to cover the entire disc’s surface. 

  When you use the Fit to CD function on a picture, it is resized independently in 
both dimensions to the full size of the CD printing area. Therefore, pictures which 
aren’t square (equal width and height) will be distorted. If you plan on using a picture to cover a CD, 
minimize the distortion by selecting a picture which is as square as possible, or crop the picture to make it 
square. 

Adjusting Picture Layering 
“Layering” means which picture will be “on top” when two or more pictures overlap in a 
MyDisc layout. You can control the ordering of pictures by using the Move to back 
and Move to front items in the picture pop-up menu. 

The illustrations below show how layering works with pictures. In the first one, the upper 
picture is “in front of” the other picture, while the second one shows the upper picture 
behind the other one. Notice that since the picture’s background color is not transparent, 
the rectangular edges of the pictures show even where the picture is “white” or clear. 

Barcode items should not be resized, as this 
may make them unreadable. 
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Text items always print “in front of” pictures, no matter how the pictures are layered. 

Deleting Items from a Layout 
You can remove any unwanted items (pictures or text) from a disc layout. Select the item you want to 
remove. Click the right mouse button to bring up the pop-up menu. Select Cut from this menu to delete the 
item. 

Saving a Layout 
When you’re done working on your layout, you can save it for later use or modification. To save a layout, 
select Save layout... from MyDisc‘s File menu. In the dialog which appears, select the folder to save 
the layout in and give the layout a name (if you’re creating a new layout) or select an existing layout file if 
you’re modifying a previously-created layout. 

Opening a Layout to Make Changes 
After you create and save a layout, you can open it at any later time and make changes to it, or print it. You 
can either choose Open layout... from the MyDisc File menu, or click on the Open layout file button 
on the toolbar (the second button from the left). This will load the layout file along with any pictures in the 
layout. 

Viewing CD Print Layouts with MyDisc 
MyDisc shows you what a particular CD layout looks like, complete with all text and pictures. To view a 
layout, open it by using the open layout button on the toolbar ( ) or by selecting Open layout... from 
the File menu. When you open a layout, all of its components (including any pictures and pre-printed 
graphics) are loaded. 

The layout you see displayed in the MyDisc workspace is the layout which will be used to print any discs 
you make. To use a different layout, either open a new one, or create a new layout. 
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When you open a layout, it will be shown in the MyDisc workspace. You can do any of the following things 
to control how the layout is displayed: 

  Display a grid over the layout: 
By clicking the grid button on the toolbar (shown here), an alignment grid will be shown over 
the disc layout. The grid has lines spaced 100 location units (or 10 mm) apart to help you line 

up text. 
To remove the grid display, click the grid button again. 

  Select the grid spacing: 
The grid spacing button on the toolbar sets the spacing 
between lines on the grid. Clicking on this button opens 

the grid spacing dialog. Select the spacing values for both the “major 
grid” (darker lines) and “minor grid” (lighter lines). The minor grid 
spacing is given as millimeters between lines, while the major grid 
spacing is given as a number of minor grid lines. 

  Display CD outlines over the layout: 
By clicking the CD outline button on the toolbar (shown here), two alignment circles will be 
shown over the disc layout. These outlines show the inner and outer boundaries of the 

printable area of a CD are also shown.  
To remove the outline display, click the outline button again. 
(Note: in order to show the CD outline, the CD coordinates item in the Options menu must be 
checked.) 
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Using ImageAligner to Print Text on Pre-Printed CDs 
ImageAligner allows you to print text on CDs which are 
already pre-printed. Using a camera mounted over the CD 
printer, this facility automatically aligns the text to be printed 
with the pre-printed graphics on the CD. The result is a CD 
which looks as if it the text and other graphics were printed 
together. 

Printing pre-printed CDs is a two-part process: 

  Before a pre-printed CDs can be printed, ImageAligner must be “trained” on its pre-printed graphic. This 
process consists of taking a “snapshot” of a blank pre-printed disc with the camera, and then manually 
aligning this snapshot on-screen. After this, ImageAligner will align printed text to this position when 
discs are printed. 
You can either first create a printing layout and then train on the preprinted image, or you can train first 
and then create the layout. In either case, when you save the layout, the trained pre-printed graphic will 
be saved as part of the layout. 

  As discs are printed when you order discs to be made, ImageAligner takes a snapshot of each disc in the 
printer tray. Pattern-matching routines compare this snapshot to the one you “trained” it on; from this 
comparison it computes the amount that the material to be printed must be rotated in order to line up 
perfectly with the pre-printed graphics on the disc sitting in the tray. Then, before the text is printed, it is 
rotated in software before being sent to the printer. The resulting printing lines up with the existing image. 

ImageAligner Is an Extra-Cost Option 
To use the ImageAligner feature, the disc production system you’re using (ImageAutomator) must be 
equipped with the option package, including the digital camera that mounts over the CD printer. If you’re 
not sure whether this option is installed, check with your system or network administrator. 

Printing Pre-Printed CDs Using ImageAligner 
After you’ve trained ImageAligner using a blank pre-printed disc, you can run print jobs on those discs by 
simply using the layout file that you saved at the end of the training process. The layout file contains a link to 
the pre-printed graphic, so every time this layout is used to print CDs, ImageAligner will activate and orient 
the text before printing it over the pre-printed graphic. 

Here’s what happens when pre-printed CDs are printed: 

1 A disc is dropped into the open printer tray. The disc is properly positioned under the camera, ready to 
have its picture taken. 

2 A “snapshot” of the disc is taken by the camera. ImageAligner analyzes this image, comparing it to the 
trained pre-printed graphic. From this comparison, it determines how far to rotate the text to be printed in 
order for it to line up with the pre-printed graphic. 

3 Before the text is printed, it is rotated in memory to match the orientation of the disc in the printer 
tray. After rotation, disc printing proceeds normally. 

Once you’ve trained a printing layout on a pre-printed disc, ImageAligner will automatically be used when 
printing using that layout. (You can disable ImageAligner if needed by selecting Remove pre-printed 
graphic from the File menu on the Create Disc Label tab.) 

For complete information on using 
ImageAligner, refer to the user’s manual 
supplied with the ImageAutomator disc 
production system used to make discs. 
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Step 3: Making Your Disc 
When you’re done selecting files and setting up the label to be printed on your disc, it’s time to go to the last 
tab and actually make the disc. Click on the Make Disc/Image tab to open it. 

This tab is where you tell MyDisc to “do it” and create the disc(s) you want. In this tab, you can also 

  Set options which control the data formatting of the disc 

  Assign a name to the disc 

  Check on any other disc-making jobs which are in progress 

The Make Disc/Image tab is shown below with some important parts labeled. 

  The disc name field is where you enter a name for your disc. This name will appear as the volume name 
of the CD when the disc is read (for instance, when someone opens the disc on their computer). 

  The number of copies field sets how many copies of the disc you have just set up will be made. The 
default number is 1. You can type in a different number or use the “spinner” controls (up- and down-
arrows) to change the number. 

  The disc contents summary area shows a list of the selections you’ve made for your disc. The first line of 
this display tells you how much data you will be putting on your disc, followed by the type of disc. (For 
data discs, the amount is given in megabytes of data; for audio discs, the total play time of the disc is 
shown.) Each selection (file or folder for a data disc, or audio track for an audio disc) that you made in the 
file selection dialog will have an entry in the summary. 

  The job status display area lets you check on any disc making jobs which are currently in progress. Each 
current job is shown with status information. See Checking Disc Jobs on page 31 for details. 

To make your disc, fill out the disc name field and select the number of copies you want, then click the 

 
button to start the disc-making process. While the disc is being made, you can watch the job 

See page 37 for notes on making a disc 
image instead of making discs. 

Disc name field # copies selector 

Disc contents
summary

Job status display

Make Disc 
button 
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status display area to check the job’s progress. When the disc is done, go to the disc production system and 
pick it up from the output stack. 

Naming the Disc 
Every CD-ROM disc has a name. This name is what will appear, at some location, when you open the disc on 
a computer. The field marked Disc name: on this dialog is where you enter the name for the disc you’re 
creating. This name can be up to 32 characters long. (Technically, this field is known as the volume identifier, or 
volume ID.) 

The exact usage and restrictions on this name field varies from one computer system to another, and depends 
on the type of disc you’re making. Therefore, you should take these restrictions into account when entering 
text into this field. 

  For ISO 9660 discs, the ISO specification imposes rather severe restrictions on the allowable characters in 
this field. Only the following characters are allowed: A-Z (uppercase only), 0-9, and the underscore 
character, _. 

  For ISO 9660 Level 2 and Rock Ridge discs, the ISO specifications still apply to this field. However, the 
operating systems used on the computers which will read these discs will accept a much larger set of 
characters. 

The moral of the story is this: use any characters other than the ISO characters described above with caution. 
(Even if the characters in this field are deemed to be “illegal” by the reading computer system, the worst 
which will probably happen is that the disc name will be shown as a blank.) If you’re concerned about 
compatibility with whatever system reads your disc, then stick to the ISO character set. 

Setting the Number of Copies 
You can make one or more copies of the disc you’re creating. If you make multiple copies, each copy will be 
identical to every other in the batch. 

When you start MyDisc, the number of copies will be set to 1. To choose another number, either type the 
number directly in the Number of copies: field, or use the “spinner” controls (the little buttons with up 
and down arrows on them) to change the number. 

Setting MyDisc’s Options 
There are several options which affect the data formatting of discs and other aspects of MyDisc’s behavior. 
These options are covered in detail in the section below, MyDisc Options on page 33. 

To change any option settings, click the  button to open the options dialog. 

Checking Disc Jobs 

When you click the  button to make your disc, what you’re actually doing is starting a disc 
production job. You can check the progress of each job by looking in the job status display area on the Make 
Disc tab. Each job gets a name, which is your user name (the name which you use to log on to your 
workstation) followed by a unique number. For instance, if you log on as Fred, one of your job names might 
be Fred143839. (Only your jobs will appear in your job status display.) 
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Each of your jobs gets an entry in the job status display area, showing the job name, the current job status, 
and the time the job was last checked or was completed. To see more details about a particular job, click on 
the job’s entry to open a job details window. 

The job details window shows the following information for each job: 

  The job name (in the title bar of the dialog) 

  How many discs you asked for (Quantity Requested) 

  How many discs were successfully made (Quantity Complete) 

  How many discs failed or were rejected (Quantity Failed) 

  The current status of the job 

Removing Job Entries 
When you get job status details, you have the opportunity to remove the job entry from the list. (You 
probably only want to do this if the job is completed successfully.) To remove the job status entry, click the 

 button. Otherwise, if you want to retain the job status information, click the  button to 
close this dialog. 

Cancelling Queued Jobs 
If, after submitting a disc-making job with MyDisc, you decide you don’t want to make the disc after all, you 
can cancel the job, but only while it is still queued. By “queued” we mean when the job is sitting in the job 
queue waiting to be started. You can tell a job is queued by checking the job status display area described 
above. Any jobs which show a status of “Queued” are still waiting to run. Once a job has started running on 
the disc production system, it can’t be cancelled. 

To cancel a queued job, open the job details window by clicking on the job entry in the job status display. In 
the details window, click the  button. The job will be removed from the job status display list. 
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MyDisc Options 
MyDisc has several option settings which control important aspects of its behavior. The  
button, located on the Make Disc dialog, opens the Preferences dialog. This dialog is divided into separate 
tabs, each a mini-dialog containing related options. Each tab is described in order below. 

Preferences—Job Tab 
This tab contains options which affect how disc production jobs—that is, each instance of an order for 
making one or more discs—are handled by MyDisc. 

  Which jobs are shown: 
This selects what jobs are displayed in the MyDisc job status display. There are two items which can be 
checked here: 

♦ Show completed jobs: 
If checked, this will put jobs which have completed in the job status display. Otherwise, completed 
jobs will disappear from the display. 

♦ Show all user’s jobs: 
If checked, all jobs from all users for the selected disc production system will be shown. Otherwise, 
only your jobs will be shown. 

  Priority: 
This sets the priority for any jobs submitted from MyDisc. The priority determines which jobs will run 
first when jobs “compete” against each other; jobs with higher priority get preference and will run before 
lower-priority jobs. The priority range is 1 to 10. 

  Folder for submitting jobs to CD-Remote: 
This selects which disc production system will be used to make your discs. This item should normally 
only be set once, when you install and set up MyDisc, and not changed after that. 
Click the  button: this opens a standard Windows file selector dialog. Navigate to the folder 
where you want jobs to be submitted; select the folder by clicking on it, then click  to put the 

name of the folder in the Look in field at the top of the dialog. Click  again which selects 
the folder and closes the dialog. (Be sure not to change or remove the filename which appears in the 
File name field.) 
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Preferences—Data Tab 
This tab contains options which affect the formatting of data discs only (not audio discs). 

  Type of disc to create: 
This choice selects the format for data discs created by MyDisc. It’s important to select the proper format 
for your disc, which depends on the type of computer system it will be read on. The choices are: 

♦ ISO 9660:  
This format creates discs which can be read by practically any computer system. ISO 9660 imposes 
some rather severe restrictions, however, most importantly on file and subdirectory names: these are 
limited to 8.3 characters (1 to 8 characters for the name followed by a period, with an optional 1-to-3 
character “extension”), and only the following characters may be used in file and subdirectory names: 
A-Z (uppercase only), 0-9, and the underscore character, _. Therefore, you cannot use ISO 9660 if 
the files you’re putting on disc have long filenames (for example, a report called Sales report-
Dec’99.doc) 

♦ ISO 9660 Level 2:  
This format creates discs which are readable both by computers which use Microsoft Windows 
(often referred to as “PCs” and by Macintosh (“Mac”) computers. It allows long names for files and 
folders. 

♦ Rock Ridge: 
This format creates ISO 9660 discs with the Rock Ridge extension, which allows long file and folder 
names. You’ll want to use this format if you’re creating discs to be read on a computer system which 
runs under the Unix operating system. (Rock Ridge is an extra-cost option which  requires licensing 
on the ImageAutomator disc production system.) 

  Job Cancellation: 
This group of options contains choices which affect how data disc production jobs are checked for 
problems (and potentially cancelled if problems occur). There is one option: 

♦ Ignore missing files:  
If this option is checked, then any files which are 
missing at the time discs are made will be ignored. 
(Files can come up “missing” if they exist at the 
time they are selected, but have been deleted by the 
time discs are actually being made.) A file can also appear to be “missing” if it is being used by 
someone else who has exclusive access to the file (for instance, if another user is editing a document). 
 
If this item is not checked, then any missing files will cause a disc production job to be cancelled. 

Leave this item unchecked if it’s critical that 
all the files you select are actually copied to 
the data disc. 
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Preferences—Audio Tab 
This tab contains options which affect the formatting of audio discs only (not data discs). 

  Pause between tracks (seconds):  
This sets the length of pause time between audio tracks. Pause time is a length of absolute silence placed 
in between audio selections. The default setting is 2 seconds. Either type in a new value, or use the 
“spinner” controls (up- and down-arrows) to change the existing time. 

  Audio file extensions:  
This selects the allowable file extensions for valid audio track files. By changing this item, you change the 
types of files which MyDisc recognizes (and displays) as valid audio data files. Only such valid file types 
will be displayed in the audio file selection tab. 
Enter the allowable “extensions” in a list, with each item separated by spaces or commas (for example, 
wav dat or wav, dat). 

The following are standard, recognized valid audio file types: 

TYPE EXTENSION NOTES 
Wave .WAV Most common type of audio track file 
Raw —any—  

Note that all audio track files used by MyDisc must meet the following criteria: 

♦ The sampling rate must be 44.1 kHz 

♦ They must be in stereo (2 channels) 

♦ They must contain 16-bit samples 
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Preferences—Disc Tab 
This tab contains options which affect the whole disc, regardless of the type (data or audio). 

♦ Size of Disc: 
This selects the data size of the discs you create. “Size” in this case doesn’t refer to the physical size of 
the discs: it means “how much data can I put on the disc?” (The size is given in terms of how much 
audio data will fit on a disc.) There are three possible sizes currently available., The default choice (74 
minutes) is by far the most common; the other two sizes are rare. The sizes are: 

DISC SIZE DATA CAPACITY 
63 minutes 550 Mb 
74 minutes 650 Mb 
80 minutes 700 Mb 

The size selection is used by MyDisc to gauge how much space is available on a disc when you’re 
selecting files and folders to put on it. This allows the file selector (the first tab) to show you how much 
space is left, and alert you when you’re close to filling a disc or have filled it. Keep in mind that these 
data capacities are approximate only. 

  Verify discs after writing: 
This setting selects whether your discs will be verified after being written (recorded or “burned”) on the 
disc production system. Verification consists of reading the entire disc and comparing it to the source 
data to make sure that the disc is a 100% accurate copy of that data. See the section Verifying Your Disc 
Copies below for a more detailed explanation. 
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Making Disc Images Instead of Discs 
Instead of making discs, you can make an image of the disc: this image is a file which contains all the data 
and formatting information needed to make a readable copy of the disc. The image can be used to make any 
number of disc copies, using disc duplication software on a Microtech disc production system. 

You can make an image instead of a disc, but you can only do this on the Microtech production system itself 
(such as the ImageAutomator 150 system). This procedure is covered in the ImageAutomator 150 User’s 
Manual. 

Verifying Your Disc Copies 
MyDisc’s job is to make CDs whose data is 100% accurate (meaning that all data on the disc exactly matches 
the source files which were selected). However, in the real world, nothing is perfect: though rare, it is possible 
for a bad disc (that is, one whose data is not exactly the same as the source files) to be made. This can be 
caused by problems with the blank media being used, the CD writer being used, or a combination of the two. 

This is why it’s important to verify disc copies after they’re made. Verification is the process of reading the 
data on each copy and comparing it to the original source data, byte by byte. If every byte is exactly the same 
as on the original disc, then the copy passes the verification pass. Otherwise, the copy is rejected, and the disc 
will be placed on the “reject” stack of the disc production system. 
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MyDisc Installation For the System 
Administrator 
You’ve found the section in the “back of the book” which is intended only for the eyes of the guru, the all-
seeing, all-knowing system administrator (or network administrator, or whatever title they are known by in 
your organization). Regardless of their title, their job is to set up the system so you can get your work done, 
and maintain it so that you can continue to do that work. So, if you’re not such a person, don’t say we didn’t 
warn you: technical stuff ahead! 

Solving the Network Puzzle 
Before delving into the details, it’s big-picture time. The diagram below shows a typical network installation 
in which users can use MyDisc to make discs on a central disc production system. Each user’s workstation 
has the MyDisc software (either the software itself or a shortcut to a central copy of that software on the file 
server: more on this choice later). 

This is not the only possible configuration for MyDisc; for instance, the disc production system (an 
ImageAutomator system) could itself be used as a file server. However, the configuration above is the 
recommended way to set things up. 

After explaining how to actually install MyDisc in the next section, we’ll revisit this configuration when it 
comes time to set up each user’s MyDisc configuration and to set up the disc production system so they can 
successfully talk to each other. This is covered in the section Selecting the Job Folder on the Network, 
starting on page 41. 

Network file server 

Disc production system 
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Remote Installation of MyDisc 
This section covers the remote installation of the MyDisc software, where the software resides on a network 
file server, and each user’s workstation only has a shortcut to this software. There are two advantages to this 
arrangement. The first is that in the event of a software upgrade, only one copy of the software needs to be 
upgraded in order for all users to have the upgraded software. In addition, having everyone use a centralized 
copy of the software allows you, the system administrator, to set the same default settings for all users. (Each 
user can still change these defaults to suit themselves, as each user’s settings are stored locally.) 

Here’s the installation procedure for remote MyDisc usage: 

1 On the network file server, follow the software installation instructions given on page 6. (All users who 
wish to use MyDisc must have access to this server.) 

2 On each user’s workstation, create a Windows shortcut to the MyDisc software. There are several ways 
to do this, depending on where the shortcut will be placed. (A shortcut can go directly on the desktop, in a 
folder on the desktop, or in the Windows Start menu.) Probably the easiest way to create a shortcut is 
directly on the desktop: 

  Right-click on any open space on the desktop. (You’ll need to close or minimize application 
windows if you can’t see the desktop.) From the menu which pops up, select New  Shortcut. 

  Follow the directions in the Create Shortcut dialog. Instead of typing a command line in the first part, 
click the  button to open a standard Windows file selector. Locate the MyDisc.exe 
application where it’s installed on the network drive which is mapped to the file server you installed 
the software on. In the next step, you can just do what the dialog title says: Select a Title for the 
Program (hint: you don’t have to name the shortcut “Shortcut to…”). 

Once you’ve finished the last step, the user will have a desktop shortcut they can double-click to start 
MyDisc. (Placing the shortcut in a desktop folder or in the Windows Start menu is left as an exercise to the 
reader.) 

Selecting the Job Folder on the Network 
This section covers a crucial part of setting up MyDisc. The illustration above on page 40 shows how the disc 
production system used to make discs for MyDisc users is attached to the network, as is the network file 
server. The important thing about this arrangement is that the CD-Remote job files (which each user creates 
whenever they make an order for a disc) should reside on the file server. (They don’t have to, but there are 
several good reasons why this is the best place for them.) 

This means that both the MyDisc software each user runs and the disc production system must agree on 
where this job folder is. 

  On the MyDisc side: 

The procedure for installing MyDisc includes selecting this folder (using the  
button on the Make Disc tab to open the Preferences dialog). 

  On the disc production system side: 
Set the IncomingDir item in the CD-Remote.CFG configuration file to the job folder. (See page 42 
for details.) 

The network file server will only require about a megabyte of free disc space for the job folder. (The actual 
data which gets copied to CD gets stored temporarily on the disc production system.) 
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Configuring Disc Production Systems for Use 
with MyDisc 
This section is for system administrators or others whose job it is to set up and maintain users’ computers and 
the disc production systems which serve MyDisc users. As MyDisc sends disc requests to a remote system for 
production, these systems must be properly configured to work properly. 

In addition to configuring the disc production system(s), the administrator also needs to configure MyDisc, 
both on a global level (on the network where the software is installed) and on each user’s workstation. 

Configuration for the disc production system(s) used by MyDisc consists of making changes to the items in 
the CD-Remote configuration file on those systems. Those items which must be set in order for MyDisc to 
work correctly are listed here. For complete descriptions of all configuration items, please refer to the CD-
Remote manual, CD-Remote: Building Custom CD-R Applications with ImageMaker Remote Job Scheduling. 

There are three settings which are necessary for MyDisc and CD-Remote to work together properly. 

  IncomingDir: <job submission folder> 
This is the folder that CD-Remote checks every few seconds for new jobs.  MyDisc must be configured to 
use this same directory in order for CD-Remote to process MyDisc orders. 

Example: 
IncomingDir: \jobs 

  LocalDir: <temporary file folder> 
Each of these statements (there can be more than one in the configuration file) tells CD-Remote which 
folders on its local hard drives can be used for creating temporary images and copies of print files. CD-
Remote will delete all these files when the job is complete.  These temporary file folders will be used in 
the order in which they appear in the configuration file, so when there are multiple hard drives on the 
disc production system, be sure to specify these temp folders in an order that spreads them evenly across 
hard drives. For example, D:\Temp, E:\Temp and F:\Temp may all be on one hard drive and 
H:\Temp, I:\Temp, J:\Temp and K:\Temp may be on a second hard drive. In this example, you 
should specify directories in the following order: D:\Temp, H:\Temp, E:\Temp, I:\Temp, etc., 
alternating between the two hard drives.  

Example: 

LocalDir: D:\Temp 
LocalDir: E:\Temp 
LocalDir: F:\Temp 

  DeleteStatusOnExit: TRUE 
This is the default setting for CD-Remote, Release 1.07, Build 5, but it was not the default for earlier 
versions. (In fact, some early versions don’t support this item at all.) MyDisc checks for the status file to 
determine if CD-Remote is running or not.  When MyDisc is about to submit a job, it checks for the status 
file and reports a warning to the user if it does not exist.  When this item is set to TRUE, CD-Remote will 
delete the status file when it is shut down.  
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Additional CD-Remote Settings for MyDisc 
There are a couple of other CD-Remote settings which may be useful for MyDisc installations. These settings 
must be used with some care. The recommended setting for each item is shown. 

  ClearLocalDirs: TRUE 
This setting causes CD-Remote to automatically delete all of the files in the specified LocalDir folders 
upon startup. (This is not recommended for installations where ImageMaker may be used to store images 
on the local hard drives.) 

  CleanupFilesDays: 7 
Typically, the CD-Remote result files will be removed when users check the final status of their jobs in 
MyDisc. This setting tells CD-Remote to clean up old result files after the specified number of days in 
case some users don't delete their own files. (This option only works with CD-Remote Release 1.07 Build 
5 and later.)  

Setting Global Defaults for All MyDisc Users 
A typical installation of MyDisc is to install a single copy on a network drive and for all users to run that 
single copy. In the folder where the executable program MyDisc.exe is located, there is a global settings 
file called MyDisc.Ini. This file can be changed with any text editor to set global preferences for all users. 
(This should only be done by a qualified administrator.) The following are the items in this file which can be 
changed: 

  JobFolder: <job submission folder> 
This is the folder where MyDisc will submit job files. CD-Remote  must be configured to use the same 
folder. 

  Verify: TRUE | FALSE 
 This should be set to TRUE or FALSE to set the default for performing (or not) a separate verify pass for 
every disc that is created.  

  PremasterType:  <disc type code> 
This sets the default type of disc to make. The type codes are as follows:  

0: ISO-9660 format 
1: ISO 9660 Level 2 format 
2: Rock Ridge format.  (This requires licensing from Microtech on the CD-Remote system. ) 

  ResultDir: <result files folder> 
This setting is optional. Typically, CD-Remote will write job result files to the same folder that the jobs 
were submitted. Over time, this may create a bit of file clutter. This setting can be used to specify an 
alternate folder for creating the result files.  

  DiscSize: <disc size code> 
The disc size codes are:  

0:  63-minute media 
1:  74-minute media (most common) 
2:  80-minute media 

  ShowAllJobs: TRUE | FALSE 
This selects whether the default setting for all users will be to show all users’ jobs in the job display (on 
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the Make Disc tab). If this setting is TRUE (and the user doesn’t change it), then all users’ jobs will show. 
Setting it to FALSE shows only the user’s own jobs. 

  ShowComplete: TRUE | FALSE 
This selects whether the default setting for all users will be to show completed jobs in the job display (on 
the Make Disc tab). If this setting is TRUE (and the user doesn’t change it), then jobs which have 
completed will show. Setting it to FALSE shows only jobs in progress. 

  AudioPause: <pause time between tracks> 
This sets the default pause time which will be inserted between tracks when making audio discs. The 
pause time is set in seconds; the default (standard pause) if this statement isn’t specified is 3 seconds. 

  AudioExtensions: <list of audio file extensions> 
This specifies which audio file types, by default, will show in the file selection window when the user is 
choosing tracks for an audio disc. The list contains the extensions without a period, separated by commas 
or spaces. The defaults (if this statement isn’t specified) are shown in the example below. 

Example: 

AudioExtensions: wav dat 

Individual users can customize their default settings. Their default choices are stored in the registry on their 
computer. 
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